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Vivado Design Flows Overview

ﬁ IMPORTANT: This tutorial requires the use of the Kintex®-7 family of devices. You will
need to update your Vivado tools installation if you do not have this device family installed.
Refer to the Vivado Design Suite User Guide: Release Notes, Installation, and Licensing
(UG973) for more information on Adding Design Tools or Devices.

Introduction

This tutorial introduces the use models and design flows recommended for use with the Xilinx®
Vivado® Integrated Design Environment (IDE). This tutorial describes the basic steps involved in
taking a small example design from RTL to bitstream, using two different design flows as
explained below. Both flows can take advantage of the Vivado IDE, or be run through batch Tcl
scripts. The Vivado Tcl API provides considerable flexibility and power to help set up and run
your designs, as well as perform analysis and debug.

-
P S

m VIDEO: You can also learn more about the Vivado Design Suite design flows by viewing the
quick take video at http.//www.xilinx.com/training/vivado/vivado-design-flows-
overview.htm.

Working in Project Mode and Non-Project Mode

Some users prefer the design tool to automatically manage their design flow process and design
data, while some prefer to manage sources and process themselves. The Vivado Design Suite
uses a project file (. xpr) and directory structure to manage the design source files, store the
results of different synthesis and implementation runs, and track the project status through the
design flow. This automated management of the design data, process and status requires a
project infrastructure. For this reason, Xilinx refers to this flow as the Project Mode.

Other users prefer to run the FPGA design process more like a source file compilation; to simply
compile the sources, implement the design, and report the results. This compilation style flow is
referred to as the Non-Project Mode. The Vivado Design Suite easily accommodates both of
these use models.

The following provides a brief overview of Project Mode and Non-Project Mode. For a more
complete description of these design modes, and the features and benefits of each, refer to the
Vivado Design Suite User Guide: Design Flows Overview (UG892).
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Introduction

Non-Project Mode

This use model is for script-based users who do not want Vivado tools to manage their design
data or track design state. The Vivado tools simply read the various source files and compile the
design through the entire flow in-memory. At any stage of the implementation process, you can
generate a variety of reports, run design rule checks (DRCs), and write design checkpoints.
Throughout the entire flow, you can open the design in-memory, or any saved design
checkpoint, in the Vivado IDE for design analysis or netlist/constraint modification. Source files,
however, are not available for modification in the IDE when running the Non-Project Mode. It is
also important to note that this mode does not enable project-based features such as source file
and run management, cross-probing back to source files, design state reporting, etc. Essentially,
each time a source file is updated on the disk; you must know about it and reload the design.

There are no default reports or intermediate files created within the Non-Project Mode. You
must direct the creation of reports or design checkpoints with Tcl commands.

Project Mode

This use model is for users who want the Vivado tools to manage the entire design process,
including features like source file, constraint and results management, integrated IP design, and
cross probing back to sources. In Project Mode, the Vivado tools create a directory to manage
the design source files, IP data, synthesis and implementation run results and related reports.
The Vivado Design Suite manages and reports the status of the source files, configuration, and
the state of the design. You can create and configure multiple runs to explore constraint or
command options. In the Vivado IDE, you can cross-probe implementation results back to the
RTL source files. You can also script the entire flow with Tcl commands, and open Vivado IDE as
needed.

Using Tcl Commands

The Tcl commands and scripting approach vary depending on the design flow used. When using
the Non-Project Mode, the source files are loaded using read verilog, read vhdl,

read edif, read ip, and read xdc commands. The Vivado Design Suite creates an in-
memory design database, to pass to synthesis, simulation, and implementation. When using
Project Mode, you can use the create project, add files, import files, and

add directories commands to create the project infrastructure needed to manage source
files and track design status. Replace the individual “atomic” commands, synth design,

opt design, place design, route design,and write bitstreamin the Batch flow,
with an all-inclusive command called 1aunch runs. The launch runs command groups the
atomic commands together with other commands to generate default reports and track the run
status. The resulting Tcl run scripts for the Project Mode are different from the Non-Project
Mode. This tutorial covers both the Project Mode and Non-Project Mode, as well as the Vivado
IDE.
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Tutorial Design Description

Many of the analysis features discussed in this tutorial are covered in more detail in other
tutorials. Not every command or command option is represented here. To view the entire list of
Tcl commands provided in the tools, consult the Vivado Design Suite Tcl Command Reference
Guide (UG835).

This Tutorial contains two labs that can be performed independently.
Lab 1: Using the Non-Project Design Flow

e Walk through a sample run script to implement the bft design.

e View various reports at each step.

e Review the vivado.log file.

e Write design checkpoints.

e Open the Vivado IDE after synthesis to review timing constraint definition and I/O planning
and demonstrate methods to update constraints.

e Open the implemented Design Checkpoint to analyze timing, power, utilization and routing.
Lab 2: Using the Project Based Design Flow

e Create a new Project.

e Walk through implementing the bft design using the Vivado IDE.

e View various reports at each step.

¢ Open the synthesized design and review timing constraint definition, I/O planning and
design analysis.

e Open the implemented design to analyze timing, power, resource utilization, routing, and
cross-probing.

e Exit and create a Tcl script from vivado.jou file (with launch runs).
e Run the design again using the newly created Tcl script.

e Open the Project in the Vivado IDE, and check that the design status is correct from the
batch run.

Tutorial Design Description

The sample design used throughout this tutorial consists of a small design called bft. There are
several VHDL and Verilog source files in the bft design, as well as a XDC constraints file.

The design targets an xc7k70T device. A small design is used to allow the tutorial to be run with
minimal hardware requirements and to enable timely completion of the tutorial, as well as to
minimize the data size.

Design Flows Overview Send Feedback 7
UG888 (v2014.2) June 4, 2014 [—\ /—]


http://www.xilinx.com/cgi-bin/docs/rdoc?v=2014.2;d=ug835-vivado-tcl-commands.pdf
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG888&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Design%20Flows%20Overview&releaseVersion=2014.2&docPage=7

A
ALL PROGRAMMABLE.

Hardware and Software Requirements

Hardware and Software Requirements

This tutorial requires that the 2014.2 Vivado Design Suite software release or later is installed.
The following partial list describes the operating systems that the Vivado Design Suite supports
on x86 and x86-64 processor architectures:

Microsoft Windows Support:

e Windows 8.1 Professional (32-bit and 64-bit), English/Japanese

e Windows 7 and 7 SP1 Professional (32-bit and 64-bit), English/Japanese
Linux Support:

e Red Hat Enterprise Workstation 6.4 and 6.5 (32-bit and 64-bit)

e SUSE Linux Enterprise 11 (32-bit and 64-bit)

e CentOS 6.4 and 6.5 (64-bit)

Refer to the Vivado Design Suite User Guide: Release Notes, Installation, and Licensing (UG973)
for a complete list and description of the system and software requirements.

Preparing the Tutorial Design Files

You can find the files for this tutorial in the Vivado Design Suite examples directory at the
following location:

e <Vivado_install_area>/Vivado/<version>/examples/Vivado_Tutorial

You can also extract the provided zip file, at any time, to write the tutorial files to your local
directory, or to restore the files to their starting condition.

Extract the zip file contents from the software installation into any write-accessible location.
e <Vivado_install_area>/Vivado/<version>/examples/Vivado_Tutorial.zip
The extracted Vivado_Tutorial directory is referred to as the <Extract_Dir> in this Tutorial.

Note: You will modify the tutorial design data while working through this tutorial. You should
use a new copy of the original Vivado_Tutorial directory each time you start this tutorial.

Design Flows Overview Send Foedback 8
UG888 (v2014.2) June 4, 2014 [—\ /—]


http://www.xilinx.com/cgi-bin/docs/rdoc?v=2014.2;t=vivado+release+notes
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG888&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Design%20Flows%20Overview&releaseVersion=2014.2&docPage=8

A
ALL PROGRAMMABLE.

Step 1: Examine the Example Script

Lab 1: Using the Non-Project Design Flow

This lab focuses on Non-Project Mode and the associated Tcl commands.

Step 1: Examine the Example Script

1. Open the example script, <Extract Dir>/Vivado_Tutorial/create_bft_kintex7_batch.tcl, in
a text editor and review the different steps.
STEP#0: Define output directory location.
STEP#1: Setup design sources and constraints.
STEP#2: Run synthesis, write design checkpoint and generate reports.
STEP#3: Run placement and optimization commands, write design checkpoint
and generate reports.

STEP#4: Run routing command, write design checkpoint and generate reports.
STEP#5: Generate a bitstream.

Notice that many of the Tcl commands are commented out. You will run them manually, one
at a time.

2. Leave the example script open, as you will copy and paste commands from it later in this
tutorial.

Step 2: Starting Vivado with the Example Design

e On Linux,

1. Change to the directory where the lab materials are stored:
cd <Extract Dir>/Vivado Tutorial

2. Launch the Vivado Design Suite Tcl shell, and source a Tcl script to create the tutorial design:

vivado -mode tcl -source create bft kintex7 batch.tcl
e On Windows,
1. Launch the Vivado Design Suite Tcl shell:

Start > All Programs > Xilinx Design Tools > Vivado 2014.x >
Vivado 2014.x Tcl Shell’

2. Inthe Tcl shell, change to the directory where the lab materials are stored:
Vivado% cd <Extract Dir>/Vivado Tutorial

! Your Vivado Design Suite installation may called something different than Xilinx Design Tools
on the Start menu.
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Step 3: Synthesizing the Design

3. Source a Tcl script to create the tutorial design:

Vivado% source create bft kintex7 batch.tcl

After the sourced script has completed, the Vivado Design Suite Tcl shell, hereafter called the Tcl
shell, displays the Tcl prompt: Vivado%

G Vivado 2014.2 Tel Shell - C:\Xilinx\Vivado\2014.2\bin\vivade.bat -mode tcl |-

resesersex Ujvado v20814.2 (64-hitd>
sS4 Build 911938 on Mon May 12 18:57:52 MDT 2814
#xxx JP Build 212831 on Mon May 12 17:24:26 MDT 2814
#% Copyright 1986-2814 Hilinx, Inc. All Rights Reserved.

Jivadox cd C:-DatasVivado_Tutorial

Jivadox source create_bhft_kintex?_bhatch.tcl

it set outputDir ./Tutorial_Created_Data~-hft_output

it file mkdir SoutputDir

#t read vhdl —-library bftLib [ glob .- Sources-hdl-sbftLib-*_.vhdl 1
: read_vhdl ./Sources hdl bft.vhdl

read_verileg [ gloh .- Sources-hdl- *_u 1]
# read_xdc .- Bourcessbft_full kintex?7.xdc
EE/Dgta/Uiuadu_Tuturia1/3uurces/hft_full_kintex?.xdc
ivadox

Figure 1: Start Vivado and Source Tcl Script

You can enter additional Tcl commands from the Tcl prompt.

Step 3: Synthesizing the Design

1. Copy and paste the synth_design command from the create bft kintex7 batch.tcl
script into the Tcl shell and wait for synthesis to complete. You can paste into the Tcl shell
using the popup menu, by clicking the right mouse button.

synth design -top bft -part xc7k70tfbg484-2 -flatten rebuilt

Note: The command in the example script is a comment. Do not copy the leading #'
character, or your command will also be interpreted as a comment.

2. Examine the synthesis report as it scrolls by.
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Step 4: Launching the Vivado IDE

3. When the Vivado Tcl prompt has returned, copy and paste the write_checkpoint,
report_timing_summary, and report_power commands that follow synthesis.

write checkpoint -force S$outputDir/post synth
report timing summary -file SoutputDir/post synth timing summary.rpt
report power -file SoutputDir/post synth power.rpt

4. Open another window to look at the files created in the output directory. On Windows, it
may be easier to use the file browser.
<Extract Dir>/Vivado_Tutorial/Tutorial Created Data/bft output

5. Use a text editor to open the various report (* . rpt) files that were created.

Step 4: Launching the Vivado IDE

Even though a Vivado project has not been created on disk, the in memory design is available in
the tool, so from the Tcl shell you can open the Vivado IDE to view the design.

Non-Project Mode enables the use of the Vivado IDE at various stages of the design process.
The current netlist and constraints are loaded into memory in the IDE, enabling analysis and
modification. Any changes to the logic or the constraints are live in memory and are passed to
the downstream tools. This is quite a different concept than with the ISE tools that require
saving and reloading files.

1. Open the IDE using the start_gui command.

Vivado% start gui

EX Vivado 2014.2 Tcl Shell - C:\Xilin\Vivado'\2014. 2\bin\vivade.bat -mode tcl =[]

INFO: [Opt 31-1381 Pushed B inverterds? to B load pind{s).
INFO: [Project 1—1111 Unisim Transformation Summary:
Mo Unisim elements were tranzformed.

INFO: [Common 17-831 Releasing license: Synthesis

156 Infos, 144 Warnings, B Critical Warnings and B Errors encountered.
=ynth_design completed successfully

=ynth_design: Tlne (z>: cpu = BA: EB 52 ; elapsed = B@:81:84 . Memory C(MB>: peak
= 6Gb6.8B78 ; gain 484332

design_1

Vivadox write checkpulnt —force SoutputDir post_synth

ti

Writing HDEF routing special nets.
lMrite HDEF Complete: Time ¢s»: cpu = AA:AA:AA ; elapsed = AA:AA:-AA.178 . Memory
(MB>: peak = 666.BYB ; gain = A.060H
C:sDatasVivado_TutorialsTutorial_Created_Data~sbhft_output-spost_synth.dcp
Uivadox report_timing_summary —file SoutputDir-post_synth_timing_summary.rpt
INFO: [Timing 38-35]1 Done szetting XDC timing constraints.
IMNFO: [T1m1ng 38-711 UpdateTimingParams: Speed grade: —-2. Delay Type: min_max. C
onstraints type: SDC.

[Timing 38—-1921]1 Multithreading enabhled for timing wpdate uwusing a maximum o
f 2 CPUs
report_timing_summary: Time (s): cpu = BA:@@:17 ; elapsed = BU:@B:16 . Memory (M
B>: peak = 977.777 ; gain = 311.787
Vivadox report_power —file SoutputDirspost_synth_power.rpt
Running Uector—less Activity Propagation...

Finished Runnlng Uector—less Activity Propagation
Vivadox start

Figure 2: Open the Vivado IDE with start_gui
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Step 4: Launching the Vivado IDE

The Vivado IDE provides design visualization and exploration capabilities for your use. From
the Vivado IDE, you can perform further analysis and constraint manipulation on the design.

4L Vivado 20142 | = =

Fle Edt Fow Tools Window Layout View Help
g &% @ @ | 5 %S pefaultLayout - ]

Synthesized Design - xc7k70tfbgd84 2 X

Netlist — O % G Device X O x

+ Nets (1726
i Leaf Cells (142

a1-{@) arnd1 (roun
(] arnd2
B-{@ arnd3 (round_3)
t)-[@] arnd4 (round_4)

w-{3] egressLoop[0].egressFifo

m

i egressLoop[1].egressFifo
w-{3] egressLoop[2].egressFifo
)-{@ egressLoop[3].egressFi
[ egressLoop[4].egressFi
)-{@ egressLoop[5].egressFifo

-{11] egressLoop[6].egressFifo
i [T egressLoop[7].egressFifo
{11 ingressLoop[0].ingressFifo
i -[@] ingressLoop[1].ingressFifo

1-[71] inoressl oon[?1.inaressFifn =

£ Sources. (3] Neblist
Properties O ox

e

Td Console — O x
oo 167 | buffer fifo lasync_fifo 15 | 168 oy
iy |68 | \ingressLoop[7].ingressFifo |FifoBuffer_14 | 169
l]] 169 | buffer fifo lasync_fifo | 168
&
5|  Finished Writing Synthesis Reporc : Time (s): cpu = 00:00:43 ; elapsed = 00:03:26 . Memozy (MB): peak = 666.070 ; gain = 530.33
X

Synthesis finished with 0 errors, 0 critical warnings and 553 warnings.

Synthesis Optimization Complete : Time (s): cpu = 00:00:50 ; elapsed = 00:03:26 . Memory (MB): peak = 666.070 ; gain = 530.398

l il »

|2 Tcl Console Messages | [ Log

Figure 3: Vivado IDE - Non-Project Mode

TIP: To stop the GUI and return to the Vivado Design Suite Tcl shell, use the stop_gui
command. If you use the File > Exit command from the Vivado IDE, you will completely
exit the Vivado tool.

Since the design does not have a project in Non-Project Mode, the Vivado IDE does not
enable source file or run management. You are effectively analyzing the current in memory
design. The Vivado Flow Navigator and other Project based commands are also not available
in Non-Project Mode.
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Step 5: Defining Timing Constraints and I/O Planning

Step 5: Defining Timing Constraints and I/O Planning

You must often define timing and physical constraints for the design prior to implementation.
The Vivado tools let you load constraints from constraints file(s), or enter constraints
interactively using the IDE.

Defining Timing Constraints

1. Open the Timing Constraints window: Window > Timing Constraints.

i Device X |if, Timi

Gl g
by o

Create Clock

[E-Clocks (2)
--Create Generated Clock
--5et Clodk Latency (0]

--Set Clock Groups (1)
--Set Clock Sense (0
-~Set Input Jitter (0)
--Set System Jitter (0)
--Set External Delay (0)
- Inputs (0]

i----SetInput Delay (0)
E-Outputs (1)

i L-SetOutput Delay (0)

1 2

--Set Clodk Uncertainty (0)|2

All Constraints

]
X

Position Clodk Name Period (ns) Rise At (ns) Fall At {ns) Add Clodk

=) 1whClk 10,000 o
=3 2 bftClk 5.000 0

Double cick fo create a Create Oock consiraint

Source Ohjects Source File

[get_ports wbClk] bft_full_kint.
[get_ports bftClk]  bft_full_kint.

X | 1B B

a, BBy bft_full_kintex7.xdc (C:/Data/Vivado_Tutorial Sources/bft_full_kintex7.xdc)
== .\ﬂ, 1. create_dock -period 10,000 -name whbClk [get_ports wbClk]

Figure 4: Define Timing Constraints

A tree view of the different types of constraints displays on the left side of the Timing
Constraints window. This is a menu of timing constraints that can be quickly defined.

Notice the two clock constraints, wbClk and bftClk, displayed in the Timing Constraint
spreadsheet on the right side of the Timing Constraints window. The values of currently
defined constraints can be modified by directly editing them in the spreadsheet.

2. In the left hand tree view of the Timing Constraints window, Double-click on Create Clock
under the Clocks category, as shown in Figure 4.

Note: Expand the Clocks category if needed by clicking on the “+°.
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Step 5: Defining Timing Constraints and I/O Planning

The Create Clock wizard opens to help you define clock constraints. Notice the Tcl
Command on the bottom displays the XDC command that will be executed.

Do not create or modify any timing constraints at this time.

é"‘_ Create Clock @

,'0', Creates a dock object. The created dock is applied to the specified source objects. If you do not specify
¥ source objects, but give a dock name, a virtual dock is created.

Clock name:
Source objects: |:|
Waveform
Period: 105 ns
Rise at: 05| ns
Fall at: 55 ns

Add this dock to the existing dock (no overwriting)

Command: | create_dock -period 10,000 -waveform {0,000 5,000}

Reference... Reset to Defaults [ OK ] | Cancel

Figure 5: Create Clock Dialog Box

3. Click Cancel.
4. Close the Timing Constraints window by clicking the X in the window tab.

The Vivado Design Suite offers a variety of features for design analysis and constraint
assignment. Other tutorials cover these features in detail, and they are only mentioned here.
Feel free to examine some of the features under the Tools menu.

I/0 Planning
Vivado has a comprehensive set of capabilities for performing and validating I/O pin
assignments. These are covered in greater detail in the I/O Planning Tutorial.

1. Open the I/O Planning view layout by selecting I/O Planning from the Layout Selector pull
down, as shown in Figure 6.

2. Make the Package window the active view if it is not active.

Note: If the Package window is not open, you can open it using the Windows > Package
command from the main menu.
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ALLPROGRAVMABLE Step 5: Defining Timing Constraints and I/O Planning

3. In the Package window, double-click to select a placed 1/0 Port,
shown as an orange block inside a package pin.

4. Drag the selected I/0 Port onto another pin site in the same I/O
bank.

5. Examine the I/O Ports window, look at the port name and package
pin site columns.

e

TO_Do4_14

6. Examine the data displayed in the 1/0O Port Properties window.
Click each of the tabs at the bottom of the window.

7. Remember the port name and site of the port you moved.

Write them down if necessary, because you will look for the LOC constraint of the placed
port in the XDC file, after implementation.

§- Vivado 2014.2 =
Fle Edit Fow Tools Window Layout View Help — EI o=l
ACHwOREXH %GO K| B [Broremng W eN ©
]
Synthesized Design - xc7k70tfbg484 2 IS Default Layout
- = 1/O Planning
Device Constraints —_ 0O » x 5 Clock Planning
Qs | X IS Floarplanning 8 9 10 11 12 13 14 15 1
oo 8 9 10 z 13 5
~ Internal VREF = DEI'-_'UQ
067 [°S Timing Analysis
. o "
51 0,675V 3 5ave As New Layout...
A 0.7V |_ResetLayout
1 0.9V c
B NONE (6)
~m» 1/0 Bank 13
- 1/O Bank 14
+mn 1f0 Bank 15
- 1/0 Bank 15
5w 1/0 Bank 33
~m» 1/O Bank 34

Drop 1/0 banks on voltages or the "NONE™ folder to setfunset
Internal VREF.

£ sources | [J] Metlist-, & Device Constraints
Properties — O x

«+[H

& Properties | [ Clock Regions

I/OParts 0O x
A, | Name Direction  Neg Diff Pair Site Fixed Bank 1jostd Vcco  Vref  Drive Strength  Slew Type  Pull Type Off-Chip Termination IN_TERM

2| =G Al ports (71)

e % whInputData (32) Input 14 LVCMOS 18 - 1800 NONE ~ NONE -

= % whOutputdata Output (Multiple) LYCMOS 18 - 1800 12 v Slow v NONE ~ FP_VTT_SO

= 3 Scalar ports (7

=

|2 Td Console | (= Messages | Ed Log | 5 Package Pins, [» 1/0 Ports

Figure 6: Open 1/0 Planning View Layout
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Step 6: Exporting the Modified Constraints

Step 6: Exporting the Modified Constraints

Modified constraints can be output for later use. You can also save design checkpoints that
include the latest changes. You will explore design checkpoints later in this tutorial.

IMPORTANT: The Vivado Design Suite does not support NCF/UCF constraints. You
i} should migrate existing UCF constraints to XDC format. Refer to the ISE to Vivado
Design Suite Migration Guide (UG911) for more information.

1. Use the Export Constraints command to output a modified XDC constraints file with the new
I[/O LOC constraint value.

File > Export > Export Constraints

The Export Constraints dialog box opens to let you specify a file name to create.

g""_ Export Constraints @

,'0‘, Please spedfy file name to export XDC constraints.

Cutput file name: | C:/DatafVivado_Tutorial/constrs_1.xdc I:l

/| Export fixed location constraints only

[ CK ] | Cancel

Figure 7: Export Constraints

2. Enter a name and location for the file and click OK.

Notice the checkbox for Export fixed location constraints only. When this is enabled, only
the LOC constraints of fixed cells are exported, rather than of all placed cells. For a more
detailed description of fixed versus unfixed cells, refer to the Vivado Design Suite User Guide:
Design Analysis and Closure Techniques (UG906).

3. Use the File > Open File command to open the constraints file in the Text Editor.
4. Browse to select the newly exported constraints file and click OK.
5. Notice the file reflects the I/O Port placement change you made earlier.

You can open any ASCII file in the Text Editor. This is helpful for editing Tcl scripts and
constraints files, and viewing reports. The Text Editor is context sensitive, and highlights
keywords and comments, when displaying file types such as Verilog, VHDL, XDC, and Tcl.

6. Select the Tcl Console tab at the bottom of the IDE, and enter the stop_gui command.

The Vivado IDE closes, and you are returned to the Tcl prompt in the Tcl shell.
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Step 7: Implementing the Design

Step 7: Implementing the Design

1. Open the create_bft_kintex7_batch.tcl script, or bring the script window to the front.

2. Individually copy and paste the Tcl commands in the script, in order from opt_design to
write_bitstream:
opt design
place design
phys opt design
write checkpoint -force SoutputDir/post place
report timing summary -file SoutputDir/post place timing summary.rpt

route design

write checkpoint -force SoutputDir/post route

report timing summary -file SoutputDir/post route timing summary.rpt
report timing -sort by group -max paths 100 -path type summary -file
$outputDir/post route timing.rpt

report clock utilization -file SoutputDir/clock util.rpt
report utilization -file SoutputDir/post route util.rpt
report power -file SoutputDir/post route power.rpt
report drc -file SoutputDir/post imp drc.rpt

write verilog -force SoutputDir/bft impl netlist.v
write xdc -no_ fixed only -force SoutputDir/bft impl.xdc
write bitstream -force S$outputDir/bft.bit

3. Examine each command and notice the various messages produced as the commands are
run.

4. Examine the files created in the output directory.
<Extract Dir>/Vivado_Tutorial/Tutorial Created Data/bft output

5. Use a text editor to open the various report (* . rpt) files that were created.
6. Open the bft_impl.xdc file.

7. Validate that the design has been implemented with the I/O Port constraint that you
modified earlier.
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Step 8: Opening a Design Checkpoint

Step 8: Opening a Design Checkpoint

The Vivado IDE can open any saved design checkpoint. This “snapshot” of the design can be
opened in the Vivado IDE or Tcl shell for synthesis, implementation, and analysis.

1.

Open the Vivado IDE again: start_gui
This loads the active design in-memory into the IDE.

You will now load the implemented design checkpoint, closing the current in-memory
design.

Open the implemented checkpoint.

Use File > Open Checkpoint and browse to select the checkpoint file:

<Extract Dir>/Vivado_Tutorial/Tutorial Created Data/bft output/
post_route.dcp

Select Yes to close the current in-memory design.
If prompted, select Close Without Saving.

Now you can use the visualization and analysis capabilities of the IDE, working from a placed
and routed design checkpoint.

Step 9: Analyzing Implementation Results

Vivado has an extensive set of features to examine the design and device data from a number of
perspectives. You can generate standard reports for power, timing, utilization, clocks, etc. With
the Tcl API, the custom reporting capabilities in the Vivado tools are extensive.

1

Run the report timing summary command to analyze timing data.

Tools > Timing > Report Timing Summary
In the Report Timing Summary dialog, click OK to accept the default run options.

Examine the information available in the Timing Summary window. Select the various
categories from the tree on the left side of the Timing Summary window and examine the
data displayed.

Now run the report timing command to perform timing analysis

Tools > Timing > Report Timing
In the Report Timing dialog, click OK to accept the default run options.
Select the path listed in the Setup area of the Design Timing Summary window.

Maximize or float the Path Properties window to look at the path details.
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Step 9: Analyzing Implementation Results

L post_route.dep - [C:/Data/Vivado_Tutorial/Tuterial_Created Data/bft_output/post route.dcp] - Vivade 2014.2

Requirement

Logic Levels 0
Clock Path Skew  -0.021ns
Clock Uncertainty (.03Sns

Data Path Delay  3.448ns (log

(===

Fle Edt Flow Tools Window Layout View Help Search commands
g E o EX#HHN SO K (G [5yorarning My & B WK
Path Properties — O a x X
+ +mE T =
= Path 21
= Summary o

[Hame > Path 21 I

Slack 0.11dns

Source [ arnd4ftransformLoop[3]. ct/multOp/CLK  (rising

Destination @ arnd4/transformLoop([3].ct/xOutStepReg_reg/B[7] (rising edoe-triggered cell DSP43E 1 dodked by bftClk ns period=5.000ns})

Path Group bftClk

Path Type

1

<

[= Source Clock Path
L Delay Type Delay Cumulative  Location Logical Resource
(dock bftCk rise edge) () 0.000 0.000
() 0.000 0,000 Site: W17 - bftClk m
net (fo=0) 0,000 0,000 I bftck
Site: W17 [ bftClk_IBUF_inst/T
i ) 0.749 0.749 Site: W17 @ bftClk_IBUF_inst/O
net (fo=1, routed) 1.901 2.650 I bftClk_IBUF
Site: BUFGCTRL_X0YD [ bftClk_IBUF_BUFG_inst/T
() 0.093 2.743 Site: BUFGCTRL_X0Y0 < bftClk_IBUF_BUFG_inst/O
net (fo=858, routed) 1279 4.022 I arnd4ftransformLoop[3].ct/dk
Site: DSP48_X1Y27 [ arnd4transformLoop[3].ct/multOp/CLK.
[= Data Path
1l Delay Type Delsy  Cumulative  Location Logical Resource
DSP48E1 (Prop dspdBel QK PIZIY () 2.860 6.882 Site: DSP48 X1v27 < arnd4/transformLoop[3].ctimultOp/P[7] 2

General | Properties  Report | Cells | Options

Timing - Report Timing - timing_2

— 0O x
AT Ea@d 4 Timing Checks - Setup
- =1
2 General Information | Mame Slack  levels  HighFanout  From To Tota
5 Settings Z == Constrained (2
(= Timing Checks (401
Y = (= bftClk (10)
5 rld (2 = - Path 21 | ol o] ilsmd4ftransformLoon[3].ctimultopjcii [arnd4/transformLoop(3]. ctjxOutStepReg_reg/B7] -
D§ ? Path 22 0 ]24 17 arnd4/transformLoop[0] . ct/multOp/CLK arnd4{transformLoop[0]. ct/xOutStepReqg_reg/A[16]
\.‘g ~% Path 23 0.124 D 17 arnd4/transformLoop[0] . ct/multOp/CLK arnd4/transformLoop[0]. ct/xOutStepReg_regA[17]
X -~ Path 24 0.124 0 17 arnd4/transformLoop[0] . ct/multOp/CLK arnd4{transformLoop[0]. ct/xOutStepReqg_reg/A[18] —
o ¢ . ’
£ Timing Summary - timing_1 X | 5] Report Timing - timing_2 X 4 b B

2 Td Console | (™ Messages | 5 Package Pins | O+ I/O Ports~, (3 Timing

Figure 8: Float the Path Properties Window

7. Restore the Path Properties window by clicking the Restore button, or the Dock button, in
the window banner.

8. In the Timing - Report Timing window, right-click to open the popup menu and select the
Schematic command to open a Schematic window for the selected path.

Note: Alternatively, you can press the F4 function key to open the Schematic window.

9. Double-click on a schematic object, such as on a cell, pin, or wire, to expand the schematic
connections, and traverse the design hierarchy.

10. Close the Schematic window, or click the Device window tab to bring it to the front.

11. In the Device window, check to ensure that the Routing Resources button HI| is enabled to
display the detailed device routing.
Notice the Device window displays and highlights the routing for the selected path.
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Step 9: Analyzing Implementation Results

[ Package X | Device X

Figure 9: Displaying the Device Routing

12. Select the Auto Fit Selection button in the Device window toolbar menu to enable the
Vivado IDE to automatically zoom into selected objects.

13. Select some additional paths from the Timing results window.
14. Examine the routing for the selected paths in the Device window.

15. Expand the Tools main menu and examine the available analysis features under the
different sub-menus such as Timing and Report.

16. Run some of the available analysis commands: Report Power, Report Clock Interaction,
Report Clock Networks, Report Utilization, etc.

Many of these Design Analysis features are covered in other Vivado tutorials.
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Step 10: Exiting the Vivado tool

Step 10: Exiting the Vivado tool

The Vivado tool writes a log file, called vivado.log, and a journal file called vivado.jou into
the directory from which Vivado was launched. The log file is a record of the Tcl commands run
during the design session, and the messages returned by the tool as a result of those
commands. The journal is a record of the Tcl commands run during the session that can be used
as a starting point to create new Tcl scripts.

Exit the Vivado IDE:
1. Select the Tcl Console window tab and type the following: stop_gui
2. Exit Vivado:
Vivado$% exit
3. Examine the Vivado log (vivado. log) file.

On Windows, it may be easier to use the file browser to locate and open the log file. The
location of the Vivado log and journal file will be the directory from which the Vivado tool
was launched, or can be separately configured in the Windows desktop icon. You will
configure this in Lab #2.

In this case, look for the log file at the following location:

<Extract Dir>/Vivado Tutorial/vivado.log’

Notice the log file contains the history and results of all Tcl commands executed during the
Vivado session.

4. Examine the Vivado journal (vivado. jou) file.

On Windows, it may be easier to use the file browser. Look for the journal file at the
following location:

<Extract Dir>/Vivado_Tutorial/vivado.jou
Notice the journal file contains only the Tcl commands executed during the Vivado session,

without the added details recorded in the log file. The journal file is often helpful when
creating Tcl scripts from prior design sessions, as you will see in the next lab.

?The vivado.log and vivado.jou may also be written to $APPDATA%\Xilinx\Vivado, or
to your /home directory.
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Step 1: Creating a Project

Lab 2: Using the Project Design Flow

In this lab, you will learn about the Project Mode features for project creation, source file
management, design analysis, constraint definition, and synthesis and implementation run
management.

You will walk through the entire FPGA design flow using an example design, starting in the
Vivado IDE. Then you will examine some of the major features in the IDE. Most of these features
are covered in detail in other tutorials. Finally, you will create a batch run script to implement the
design project and see how easy it is to switch between running Tcl scripts and working in the
Vivado IDE.

Step 1: Creating a Project

Launching Vivado

e On Linux,

1. Change to the directory where the lab materials are stored:

cd <Extract_Dir>/ Vivado Tutorial

2. Launch the Vivado IDE:

vivado

¢ On Windows, before clicking the desktop icon to launch the Vivado tool, configure the icon
to indicate where to write the vivado.log and vivado. jou files.

1. Right-click on the Vivado 2014.x Desktop icon and select Properties from the popup menu.

2. Under the Shortcut tab, set the Start in value to the extracted Vivado Tutorial directory, as
shown in Figure 10:

<Extract Dir>/Vivado_Tutorial/

3. Click OK to close the Properties dialog box.
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- Vivado 20141 Properties [=23w)
Security I Details | Previous Versions
Genaral | Shortcut | Compatibility
Er . Vivado 2014.1
Target type: Application
Target location: wink4d.o
Target: wvgl.exe C:\lirod\Wivado 2014, 1 bin\wivado bat
Start in: C:/Data/Vivado_Tutorial
Shortcut key:  None
Run: l Normal window v]
Comment: Vivado 20141
Cpen File Location ] l Change lcon... ] l Advanced... ]
[ ok || cancel || mppy |

4. Double-click the Vivado 2014.x Desktop icon to start the Vivado IDE

Figure 10: Configuring the Start in Directory

Creating a New Project

o vk wN o=

Click Next.

Design Flows Overview
UG888 (v2014.2) June 4, 2014

Click Next in the New Project wizard.
Specify the Project Name and Location:

Project name: project_bft

Project Location: <Extract_Dir>/Vivado_Tutorial/Tutorial_Created_Data

Step 1: Creating a Project

After Vivado opens, select Create New Project on the Getting Started page.
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AL PROGRAVMABLE Step 1: Creating a Project
gl":_:. MNew Praject @
Project Name
Enter a name for your project and specify a directory where the project data files will be stored a:':/

Project name: | project_bft
Project location: | C:/Data/Vivado_Tutorial/Tutorial_Created_Data I:l
/| Create project subdirectory

Project will be created at: C:/Data/Vivado_Tutorial [Tutorial_Created_Data/project_bft

| < Back “ Next = Finish Cancel

Figure 11: Create New Project

7. Select RTL Project as the Project Type and click Next.
8. Click Add Files...
a. Browse to <Extract Dir>/Vivado Tutorial/Sources/hdl/

b. Press and hold the Ctrl key, and click to select the following files:
async_fifo.v, bft.vhdl, bft tb.v, FifoBuffer.v

c. Click OK to close the File Browser.

9. Click Add Directories...
a. Select the <Extract Dir>/Vivado_Tutorial/Sources/hdl/bftLib directory
b. Press Select.

10. Click in the HDL Sources for column for the bft tb.v and change Synthesis and
Simulation to Simulation only, as shown below.

11. Click in the Library column for the bftLib, and manually edit the value to change it from
xil_defaultlib (or work) to bftLib, as shown in Figure 12.

Design Flows Overview Send Feedback 24
UG888 (v2014.2) June 4, 2014 [—\ /—]


http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG888&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Design%20Flows%20Overview&releaseVersion=2014.2&docPage=24

3¢

12.

13.

14.

15.
16.

17.
18.

19.
20.
21.

XILINX

AL PROGRAMMABLE Step 1: Creating a Project
gl".f_? Mew Project @
Add Sources
Spedfy HOL and netlist files, or directories containing HOL and netlist flles, to add to your project. Create a new source file on
disk and add it to your project. You can also add and create sources later.
Index Name Library HOL Source For Location
W 1 FifoBuffer.v wil_defaultib . Synthesis & Simulation ~ C:/DataVivado_Tutorial/Sourcesfhdl
we 2 async_fifo.v xil_defaultib . Synthesis & Simulation = C:/Data/Vivado_Tutorial/Sources/hdl
wh 3 bft.vhdl xil_defaultib o Synthesis & Simulation - C:/Data/Vivado_Tutorial/Sources/hdl =
wE 4 bft_th.v xil_defaultib . Simulation only ~ C:/Data/Vivado_Tutorial/Sources/hdl ‘
B 5 bftLib bftLib » Synthesis & Simulation = C:/Data/Vivado_Tutorial/Sources/hdl +
£
Add Files... | | Add Directories. .. | | Create File...

Scan and add RTL indude files into project

W'| Copy sources into project
| Add sources from subdirectories

Target language: | Verilog = | Simulator language: | Verilog =

| < Back |[ Mext = Einish Cancel

Figure 12: Add RTL Sources

Enable the check boxes for Copy sources into project, and Add sources from
subdirectories.

Set the Target Language to Verilog to define the language of the netlist generated by
Vivado synthesis.

Set the Simulator Language to Verilog to define the language required by the logic
simulator.

Click Next.

Click Next again to skip past the Add Existing IP page, since you will not be adding IP at this
time.

On the Add Constraints page, click Add Files...

Browse to and select
<Extract Dir>/Vivado_Tutorial/Sources/ bft full kintex7.xdc.

Click OK to close the File Browser.
Enable the check box for Copy constraints files into project.

Click Next to move to the Default Part page.
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Step 1: Creating a Project

& MNew Project
Add Constraints (optional)
Specify or create constraint files for physical and timing constraints.

Constraint File Location

A% bft_full_kintex7.xdc C:\Data\Vivado_Tutorial\Sources

[ AddFies., | | createFie..,

Copy constraints files into project

Finish

Cancel

EXS

Figure 13: Add Constraints

22. On the Default Part page, click the Family filter and select the Kintex-7 family

23. Scroll to the top of the list and select the xc7k70tfbg484-2 part, and click Next.

24. Click Finish to close the New Project Summary page, and create the project.

éjﬂ Mew Project @I
Default Part
Choose a default ¥ilinx part or board for your project. This can be changed later. ‘
Spedfy Filter
& Parts Product category | All - Package | All Remaining o
@ Boards Family | Kintex-7 - | Speed grade | All Remaining -
Sub-Family | All Remaining | Temp grade | All Remaining -
Reset Al Filters
Search
IO Pin Available LuT ) Blodk Gb Gl
Bt Count I0Bs Elements FlipFiops RAMs B Transceivers  Tr
434 285 41000 32000 135 240 4 4 .
N FER I I PR I R N
@ xcTkT0tbg484-2L 434 285 41000 32000 135 240 4 4
@ xcTkT0tbg484-1 434 285 41000 32000 135 240 4 2
@ xcTk70ttbgs 75-3 a7o 300 41000 32000 135 240 8 3
& xcTk70tfbgs 75-2 a7o 300 41000 32000 135 240 8 3
@ xcTkT0tbgs 76-2L a7o 300 41000 32000 135 240 8 3
& xcTkT0tfbgs 75-1 a7o 300 41000 32000 135 240 8 3
@ xcTkT0Hfbg484-2L 434 285 41000 32000 135 240 4 4
& xcTkT0HfbgsT6-2L a7o 300 41000 32000 135 240 8 B
P il — = T T ’ 3
[ < Back ][ MNext = ] Einish

Figure 14: Selecting the Default Part
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Step 2: Using the Sources Window and Text Editor

The Vivado IDE opens project bft in the default layout.

4. project_bft - [C:/Data/Vivado_Tutorial/ Tutorial_Created_Data/project_bft/project_bft.xpr] - Vivado 2014.2 [rorl-2-] 3]
Fle Edit Flow Tools Window Layout View Help
Pl ] | & b %8 | X @ 1S DefaultLayout P & B N2 Ready
Flow Navigatar % Project Manager - project_bft X
Q= Sources I VE L Project Summary X [mER
A= e = | Prog - i
oject Project Setti Edit =
=P Manager  Design Sources (1) = e =7
= 1) = .
3 Project Settings T e bft - aBFT . = | Project name: project_bft
3% Add Sources - Constraints (1) Product family:  Kintex-7
L 1P Catalog 4] (51 Simulation Sources (1 Project part: ACTHTOtbg484-2
Top module name: bft
4 1P Integrator
4 Synthesis A Implementation A
+¥ Create Block Design
¥ Open Block Design Status: = Mot started Status: =} Not started
Generate Block Design Messages: Mo errors or warnings Messages: Mo errors or warnings
Part: xc7k70tfbg484-2 Part: xc7kT0tbg484-2
4 Simulation Strategy:  Vivado Synthesis Defaults Strategy: Vivado Implementation Defaults
% simulation Settings Hierarchy | Libraries | Compile Order Incremental Comple: Mone
() Run Simulation &b Sources |  Templates
4 RTL Analysis Properties — 0w = DRC Violations A Timing S
&= = |
> E& Open Elaborated Design S
DRC information is not available because it hasn't been run Timing information is not available because it hasn't been run
4 Synthesis
@ Synthesis Settings . N
Utilization E3 Power E3
> Run Synthesis
> @ Open Synthesized Design , \
Utilization information is not available because it hasn't been run Power information is not available because it hasn't been run
4 Implementation
&% Implementation Settings
[» Run Implementation
> [ Open Implemented Design
Design Runs — 0w x
4 Program and Debug .
@ Bitstr Setti A | Name Constraints WNS TNS WHS THS TPWS Failed Routes LT BRAM DsP Start Elapsed Status|
e SETngs T | = synth_1 constrs_1 Not sta
¥ . ol |ES - -
ﬂ GEeEIE Ry =] “- = impl_1 constrs_1 Not sta
» g% Open Hardware Manager e
4
»
.|
*
g < m (=
2 Td Console | Messages | [d Log | |2 Reports', 3 Design Runs

Figure 15: Project BFT in the Vivado IDE

Step 2: Using the Sources Window and Text Editor

The Vivado tool lets you add different design sources, including Verilog, VHDL, EDIF, NGC
format cores, SDC, XDC, and TCL constraints files, and simulation test benches. These files can
be sorted in a variety of ways using the tabs at the bottom of the Sources: Hierarchy, Library or

Compile Order.

The Vivado IDE includes a context sensitive text editor to create and develop RTL sources,
constraints files, and Tcl scripts. You can also configure the Vivado IDE to use third party text
editors. Refer to the Vivado Design Suite User Guide: Using the IDE (UG893) for information on

configuring the Vivado tool.
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Exploring the Sources Window and Project Summary

Step 2: Using the Sources Window and Text Editor

1. Examine the information in the Project Summary. More detailed information is presented as

the design progresses through the design flow.

2. Examine the Sources window and expand the Design Sources, Constraints and Simulation

Sources folders.

Sources |

s
¥

A= et B|E
=I-{= Design Sources (1]
=} (¢t % bt - aBFT (bt vhd) (&)

-l arnd1 - round_1-aR1 {round Lvhd) (1]
fi arnd2 - round_2 -aR2 (ro
fi arnd3 - round_3 - aR3 (ro
0 arnd4 - round_4 - aR4 (round_4,vhdl) (1]
t-{¥# ingressLoop.ingressFifo - FifoBuffer (F
+|-i# egressLoop. egressFifo - FifoBuffer {FifobL
—I-{= Constraints (1]
=7 constrs_1 (1]

ol bft_full_kintex7.xdc
=I-{= Simulation Sources (1]

Sl sim_1 (1)

-ty bft_th (bft_th.v) (1]
-l uut - bft - aBFT (bft.vhdl) (5]

Hierarchy | Libraries | Compile Order

45 Sources | ' Templates

Figure 16: Viewing Sources

The Design Sources folder helps keep track of VHDL and Verilog source files and libraries.
Notice the Hierarchy tab is displayed by default.

3. Select the Libraries tab and the Compile Order tabs in the Sources window and notice the
different ways that Sources are listed.

The Libraries tab groups source files by file type. The Compile Order tab shows the file order

used for synthesis.

4. Select the Hierarchy tab.

Exploring the Text Editor

1. Select one of the VHDL sources in the Sources window.
2. Right-click to review the commands available in the popup menu.
3. Select Open File, and use the scroll bar to browse the file contents in the Text Editor.

You can also double-click on source files in the Sources window to open them in the Text
Editor.
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T Project Summary ¥ | round_Llvhdl

o C:/Data/Vivado_Tutorial/Tutorial_Created_Data/project_bftfproject_bft.srcsfsources_1fimports fhdl/bftlib/round_1.vhdl
40 use bitlib.bftPackage.all;

45
50 architecture aRl of round 1 is
CH__J 51 constant u : ulype :=
|52 (¥"o123",
53 K"4567",

41

42 entity round_1 is
}f’ 43 port (
= 24 clk: in std logics
Ej 45 X : in xType;
13| a6 x0ut : cut xIype
b 4EY -
."l."l 48 end entity round_1;

Figure 17: Context Sensitive Text Editor

Notice that the Text Editor displays the RTL code with context sensitive coloring of keywords
and comments. The colors and fonts used to display reserved words can be configured using
the Tools > Options command. Refer to the Vivado Design Suite User Guide: Using the IDE
(UG893) for more information.

4. With the cursor in the Text Editor, right-click and select Find in Files. Notice also, the
Replace in Files command.

The Find in Files dialog box opens with various search options.

g Find in Files (23]

Eind what:
dk

Options
[ Match case
["] Match whole werd

[ Use:

@) Regular Expressions Wildcards

Scope

Enabled design sources (3)
Enabled constraints (1)

Enabled simulation sources (1)

Open in a new tab

[ Find ] l Close

Figure 18: Using Find in Files

5. Enter clk in the Find what: field, and click Find.

The Find in Files window displays in the messaging area at the bottom of the Vivado IDE.
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1

I Step 3: Elaborating the RTL Design
Find in Files - 125 occurrences of 'dk’ in 10 of 11 project files T
a, —--Fc_:und usages (725 usages)
= -l C:/DataMivado_Tutorial fTutorial_Created_Data/project_bftfproject_bft.srcsfsources_1jimports/hd/bftLib/core_transform.vhdl (5 ussges)
':.' ‘a0, 5) clk : in std_logic;
=]
=2 4] process (clk)
(58, 29) if rising_edge(clk) then
2} process (clk)
I ifrising_edge(clk) then
& C;fDamNivado_TutarialfT utorial_Created_Data project_bftjproject_bft.sresfsources_1imports hdl FifoBuffer.v /5
+ C: DataMivado_Tutorial {Tutorial_Created_Data/project_bft/project_bft.srcsfsources_1fimportsfhdlbftLib/round_4.vhdl ; e
+vh C:/DataVivado_Tutorial /Tutorial_Created_Data/project_bftfproject_bft.sresfsources_1fimportshdlbftLib/round_3.vhdl /5 ussges)
125 occurrences of 'clk’ in 10 of 11 project files x
&) Td Consale | (O Messages | [ Log | [2) Reports | 3 Design Runs 45 Find in Files
Figure 19: Viewing the Find in Files Results
6. In the Find in Files window, expand one of the displayed files, and select an occurrence of clk
in the file.
Notice that the Text Editor opens the selected file and displays the selected occurrence of
clk in the file.
7. Close the Find in Files — Occurrences window.
8. Close the open Text Editor windows.

The next few steps highlight some of the design configuration and analysis features available
prior to running synthesis.

Step 3: Elaborating the RTL Design

The Vivado IDE includes an RTL analysis and IP customizing environment. There are also several
RTL Design Rule Checks (DRCs) to examine ways to improve performance or power on the RTL
design.

1.
2.

Select Open Elaborated Design in the Flow Navigator to elaborate the design.

Ensure that the Layout Selector pull down menu in the main Toolbar has Default Layout
selected.

The Elaborated Design enables various analysis views including an RTL Netlist, Schematic,
and Graphical Hierarchy. The views have a “cross-select” feature, which helps you to debug
and optimize the RTL.

Explore the logic hierarchy in the RTL Netlist window and examine the Schematic.

You can traverse the schematic by double-clicking on cells to push into the hierarchy, or by
using commands like the Expand Cone or Expand/Collapse from the Schematic popup
menu. Refer to the Vivado Design Suite User Guide: Using the Vivado IDE (UG893) for more
information on using the Schematic window.
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10.

Step 4: Using the IP Catalog

Select any logic instance in the Schematic and right-click to select the Go to Source or Go
to Definition commands.

The Text Editor opens the RTL source file for the selected cell with the logic instance
highlighted. In the case of the Go to Definition command, the RTL source file containing
the module definition is opened. With Go to Source, the RTL source containing the instance
of the selected cell is opened.

Click on the Messages window at the bottom of the Vivado IDE, and examine the messages.
Click the Collapse All button in the Messages toolbar.
Expand the Elaborated Design messages.

Notice there are links in the messages to open the RTL source files associated with a
message.

Click one of the links and the Text Editor opens the RTL source file with the relevant line
highlighted.

Close the Text Editor windows.

Close the Elaborated Design by clicking on the X on the right side of the Elaborated Design
window banner and click OK to confirm.

Step 4: Using the IP Catalog

The Xilinx IP Catalog provides access to the Vivado IP configuration and generation features.
You can sort and search the Catalog in a variety of ways. IP can be customized, generated, and
instantiated.

1.

2
3.
4

Click the IP Catalog button in the Flow Navigator.

Browse the IP Catalog and examine the various categories, and IP filtering capabilities.
Expand the Basic Elements folder.

Double-click on DSP48 Macro

The Customize IP dialog is opened directly within Vivado. The Vivado Design Suite allows
you to perform native customization and configuration of IP within the tool. To learn more
about IP configuration and implementation, see the Vivado Design Suite User Guide:
Designing with IP (UG896) and the Vivado Design Suite Tutorial: Designing with IP (UG939).

Click Cancel to close the Customize IP dialog without adding the IP to the current design.

Close the IP Catalog tab by clicking on the X on the right side of the window banner.
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Step 5: Running Behavioral Simulation

The Vivado IDE integrates the Vivado Simulator, which enables you to add and manage
simulation sources in the project. You can configure simulation options, and create and manage
simulation source sets. You can run behavioral simulation on RTL sources, prior to synthesis.

1. In the Flow Navigator, under Simulation, click the Simulation Settings command.

4 Project Settings @
, 3 : Simulation |
Target simulator: Vivado Simulator -
General
|‘.;ﬁjq Simulator language: Verilog -
Simulation Simulation set: = sim_1 -
@ Simulation top module name: | bft_tb I:I

v

5
=
]
[
13

/| Clean up simulation files

v

Generate scripts only

Implementation

% ) Compilation | Simulation | Netlist | Advanced
004
Bitstream Verilog options: I:l
EN= Generics/Parameters options: I:l
P
= —debug |tYPiC3| | =
—mt |auh0 | L
SDF Delay |5d'ﬁ'nax | I
—rangecheck

Enszhle fast cimulatinn models

Select an option above to see a description of it

OK i | Cancel Apply

Figure 20: Simulation Settings - Update

2. Examine the settings available under each tab: Compilation, Simulation, Netlist, Advanced;
then Cancel to close the dialog box.

3. Click the Run Simulation command in the Flow Navigator, then click the Run Behavioral
Simulation in the sub-menu.

4. Examine and explore the Simulation environment.

Simulation is covered in detail in the Vivado Design Suite User Guide: Logic Simulation
(UG900) and the Vivado Design Suite Tutorial: Logic Simulation (UG937).

5. Close the Simulation by clicking the X icon on the Simulation view banner.

6. Click No if prompted to save changes.
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Step 6: Reviewing Design Run Settings

One of the main differences between the Non-Project Mode you used in Lab #1, and the Project
Mode which you are now using, is the support of design runs for synthesis and implementation.
Non-Project Mode does not support design runs.

Design runs are a way of configuring and storing the many options available in the different
steps of the synthesis and implementation process. You can configure these options and save
the configurations as strategies to be used in future runs. You can also define Tcl.pre and
Tcl.post scripts to run before and after each step of the process, to generate reports before and
after the design progresses.

Before launching the synthesis and implementation runs you will review the settings and
strategies for these runs.

1. In the Flow Navigator, select Synthesis Settings under Synthesis.

The Project Settings dialog box opens. The Synthesis Settings provides you access to the
many options available for configuring Vivado synthesis. For a complete description of these
options, see the Vivado Design Suite User Guide: Synthesis (UG901).

‘I‘.:'I_:- Project Settings @
| ) | Synthesis |
@J Constraints
General
'_“1 Default constraint set: | = constrs_1 (active) -

WLl
Simulation Options
@ Strategy: A& Vivado Synthesis Defaults (Vivado Synthesis 2014) -~ | [
Synthesis Description:  Vivado Synthesis Defaults
D =l Synth Design (vivado) &
Implementation tel.pre
% td.post
o -flatten_hierarchy |rebuilt | L
Bitstream -gated_dodk_conversion |of‘f | T
_ -bufg 12
= ~fanout_limit 10,000
P -directive | Default |
~fsm_extraction | auto |

+eep_equivalent_registers

—esource_sharing | auto

Select an option above to see a description of it

| OK | | Cancel Apply

Figure 21: Synthesis Settings
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2. After reviewing the various synthesis options, select the Implementation button on the left
side of the Project Settings dialog box, as shown in Figure 21.

The Project Settings change to reflect the Implementation settings. You can view the
available options for implementation runs. For a complete description of these options, see
the Vivado Design Suite User Guide: Implementation (UG904).

ﬁI” Project Settings @
P Implementation |
@ Constraints
General
P m Default constraint set: | = constrs_1 (active) -
wll !
Simulation Options
@ Incremental compile: ||
Synthesis ) 3 ' . .
Strategy: A Vivado Implementation Defaults (Vivado Implementation... « | £
|> Description: Vivado Implementation Defaults
Implementation =) Opt Design (opt_design) -
[, .
?_} s is_enabled =
. oo td.pre
Bitstream tdl.post
== -verbose [l
-directive [Default
P
- More Options
=l Power Opt Design (power_opt_design)
is_enabled [
td.pre
£ rnct a2
Select an option above to see a description of it
[ OK ] [ Cancel Apply

Figure 22: Implementation Settings

3. Click Cancel to close the Project Settings dialog box.

You are now ready to launch Vivado synthesis and implementation.
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Step 7: Synthesizing and Implementing the Design

Step 7: Synthesizing and Implementing the Design

After configuring the synthesis and implementation run options, you can:

Use the Run Synthesis command to run only synthesis.

Use the Run Implementation command, which will first run synthesis if it has not been run,
then run implementation.

Use the Generate Bitstream command, which will first run synthesis and then run
implementation if they have not been run, then write the bitstream for programming the
Xilinx device.

For this tutorial, we will run these steps one at a time.

1

In the Flow Navigator, click on the Run Synthesis button, and wait for this task to complete.

Notice the progress bar in the upper-right corner of the Vivado IDE, indicating the run is in-
progress. Vivado launches the synthesis engine in a background process to free up the tool
for other actions. While the synthesis process is running in the background, you can
continue browsing Vivado IDE windows, run reports, further evaluate the design. You will
notice that the Log window displays the synthesis log at the bottom of the IDE. This is also
available through the Reports window.

After synthesis has completed, the Synthesis Completed dialog box prompts you to choose
the next step.

Synthesis Completed @

{0} Synthesis successfully completed.

Open Synthesized Design

View Reports

Don't show this dialog again

| OK || Cancel |

Figure 23: Synthesis Complete

2. Select Run Implementation, and click OK.

The implementation process is launched, and placed into a background process after some
initialization. The next step in this tutorial shows you how you can perform design analysis of
the synthesized design, while you wait for implementation to complete.
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Step 8: Analyzing the Synthesized Design

Step 8: Analyzing the Synthesized Design

Opening the synthesized design enables design analysis, timing constraint definition, I/O
planning, floorplanning and debug core insertion. These features are covered in other tutorials,
but you can take a quick look in this step.

1. While implementation is running, select Open Synthesized Design in the Flow Navigator
and wait for the design to load.

Notice that as the Vivado IDE opens the synthesized design, the implementation continues
running in the background. At some point while you are exploring the synthesized design,
implementation will complete, and the Implementation Completed dialog box prompts you
to choose the next step.

Implementation Completed @

[o:l Implementation successfully completed.

Mext

‘@ Dpen Implemented Desigre

Generate Bitstream

View Reports

Don't show this dialog again

| OK || Cancel |

Figure 24: Implementation Complete

2. Click Cancel to close the dialog without taking any action.

This leaves the synthesized design open. You will open the implemented design after you
are finished examining the features of the synthesized design.

3. Ensure that the Layout Selector pull down menu in the main Toolbar has Default Layout
selected.

4. Click the Reports window tab at the bottom of the Vivado IDE.

If the Reports window is not open, you can open it with Windows > Reports.
Double click the Vivado Synthesis Report to examine the report.

Double click the Utilization Report to examine the report.

Close all reports when you have finished examining them.

®© N o wu

Click the Messages window tab at the bottom of the Vivado IDE.

If the Messages window is not open, you can open it with Windows > Messages.
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The Messages window provides message type filters in its banner, to display or hide
different types of messages: Errors, Critical Warnings, Warnings, Info, and Status.

Step 8: Analyzing the Synthesized Design

L

9. Click the Collapse All button to condense all of the Messages. ==

10. Expand the Synthesis messages.

11. Scroll through the Synthesis messages and notice the links to specific lines within source
files. Click some of the links and notice the source file opens in the Text Editor with the

appropriate line highlighted.

| synthesized Design - xc7k70tfbae84 2 (active) x|
Netlist — 0O 2 % I Project Summary X | @ Device X | @i bftwhdl x [E
Z _>,‘3:] B C:/Data/Vivado_Tutorial/Tutorial_Created_Data/project_bftfproject_bft.sres/sources_1fimports/fhdl/bft.vhdl
-~ ) g4 zignal loadEgressFifo : std logic wecter (7 downto 0); -
— | ¥ a5
W 6 gignal wbDataForInputReg : std logic;
xib &7
T B8 --data needs two levels of pip ning
jE 89 zignal wbInputDataStagel, wbInputDataStagel : std logic wector (31 downto 0)F
gressLuuD[Oi.egrassF\fu (FifoBuffer_&) E 1;3 20
gressLoop(1].egressFifo (FifoBuffer 3| 91lbegin |
gressLoop[2].egressFifo (FifoBuffer 13) ﬂ 92 :‘
gressLoop[3].egressFifo (FifoBuffer) 93 -—get the data ba sync with the enable 3
gressLoop[4].egressFifo (FifoBuffer_14) 94 proceas (wbClk) —
egressLoop[5].egressFifo :Fift-Euffer_E'; 'J 85 begin
egressLoop[6].egressFifo (FifoBuffer_5) — | o
earessLoop[7].egressFifo (FifoBuffer_8) & 96 wbInputDataStage0 <= wbInputData;
ingressLoop[0].ingressFifo (Fifosuffer_12) a7 wbInputDataStagel <= wbkInputDataStagel;
gressLoop[1].ingressFifo (FifoBuffer_3) a :;’ 98 end process;
gressLoop[2].ingressFifo (FifoBuffer_11) ‘w_\ 99
{0 inaress| oonl3LinaressFifo (Fifofuffer 7) o |« 100 --state machine to load data from the WB bus to the input fifes
£ Sources. (] Netlist 7| 101process (wbClk)
Source File Properties — O x 2 Lz beglr.]_ L.
103 if rising edge (wbClk) then
& =5 Ralk 104 -
(@ bft.vhdl 105 if ({reset = '1') then
106 readIngressFifo <="1";
Location: C:,.'Da13Mvado_Tubor\alﬂ'utoria\_Creahed_Dan‘project_; 107 loadState <= 307
Type: L E] |i| 108 wbDataForInputReg <= '0";
109 else
Library: work E] 110 readIngressFifo <="0";
Sige: 10.9KB 111 loadState <= loadNextState;
- . . - S 112 wbDataForInputReg <= wbDataForInput:
g i oi[=] 113 end if; -
General | Properties 4| I | +
Messages [Ealid
O, | [¥] @ 2 critical warnings  [V] () 107 warnings (V] () 288infos [ | (i) 354 status
Z @ [Common 17-201] Sourding tdl script 'C: Ysers\yandyh, XLNXYAppData\Roaming Xilinx Vivadojinit. tcl -
% (@ [Common 17-347] Attempting to get a license for feature 'Synthesis’ andfor device 'xc7k70t =1
@ [Common 17-349] Got license for feature 'Synthesis' andjor device 'xc7k70t
B @ rsynth 8-638) synthesizng module ‘b7 [oft.vhd:53]
{m} RON[synth 8-614] signal 'whInputData' is read in the process but is not in the sensitivity list [bft.vhdl:94]
- (1) [Synth 8-614] signal ‘wbInputDataStagel’ is read in the process butis notin the sensitivity list [bft. vhdl:94]
(@ [Synth 8-226] default block is never used [bft.vhdl: 129]
i@ [Synth 8-638] synthesizing module 'round_1' [round 1.vhdl:50]
@ [5ynth 8-638] synthesizing module 'coreTransform' [core_transform. vhdl:60
(@ [Synth 8-256] done synthesizing module 'coreTransform’ (1#15) [core_transform. vhdl:60]
@ TSunth 8-2561 done sunthesizinn modle 'round 1 (2215) fround_1.vhdl: 501 A
< m =]

5 Td Conscle, ( Messages | [d Log | |2 Reports | (% Design Runs | 45! Find in Files

Figure 25: Synthesis Messages Linked to Source Files

12. In the Flow Navigator, under Synthesized Design, select Report Timing Summary.

The Report Timing Summary dialog box opens. Examine the various fields and options of

this command.

13. Click OK to run with default options.

The Timing Summary Results window opens.
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Step 8: Analyzing the Synthesized Design

Timing - Timing Summary - timing_1 — 0O 2 X
O T2 = = ? @ 4 Design Timing Summary
..... L ; »
g f_ener:' It';f"rmah"” Setup Hold Pulse Width
----- [Z) Timer Settings
_____ 2 Worst Negative Slack (WNS): 0.221ns | | Worst Hold Slack (WHS): -0.085ns | | Worst Pulse Width Slack (WPWS): 2.127ns
..... =j Clock Summary (2] Total Negative Slack (TMS):  0.000ns | | Total Hold Slack (THS): -0.085 ns | | Total Pulse Width Negative Slack (TPWS): 0.000 ns
A iming (55 umber of Failing Endpoints: umber of Failing Endpoints: umber of Failing Endpoints:
£} Check Timing (52 Mumber of Failing Endpaints: 0 Mumber of Failing Endpoints: 1 Mumber of Failing Endpoints 0
g ! ;nlra-(é:od; Eams Total Mumber of Endpoints: 3509 Total Mumber of Endpoints: 9509 Total Mumber of Endpeints: 1660
-1 Inter-Clock Paths
----- [Z) Other Path Groups Timing constraints are not met.
----- |2 User Ignored Paths
[#-I= Unconstrained Paths
|2 Timing Summary - timing_1 X |
5 Td Console | ( Messages | (4 Log | 5 Reports | 3» Design Runs- (2 Timing | 55 Find in Files

14.

15.

Figure 26: Report Timing Summary

Examine the Timing Summary Results window showing timing estimates prior to
implementation. Click on some of the reporting categories in the tree on the left side of the

Timing Summary Results window.

Select Report Power in the Flow Navigator.

The Report Power dialog box opens. Examine the various fields and options of this

command.

Click OK to run with default options.

The Power Results window opens. Examine the Power Results window showing power
estimates prior to implementation. The report is dynamic, with tooltips providing details of
the specific sections of the report when you move the mouse over the report, as shown in

Figure 27.

Click on some of the reporting categories in the tree on the left side of the Power Results

window to examine the different information presented.
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Figure 27: Report Power

16. Close the Report Timing Summary window, the Power Report window, and any open
Text Editor windows.

Step 9: Analyzing the Implemented Design

The Vivado IDE is interactive, enabling editing of design constraints and netlists on the in-
memory design. When you save the design, constraint changes are written back to the original
source XDC files. Alternatively, you can save the changes to a new constraints file to preserve the
original constraints. This flexibility supports exploration of alternate timing and physical
constraints, including floorplanning, while keeping the original source files intact.

Opening the Implemented Design

1. Select Open Implemented Design in the Flow Navigator.
2. Select Yes to close the synthesized design and Don’t Save, if prompted.

After the Implemented Design has loaded, you can see the implementation results in the
Device window.

3. Click on the Reports window tab at the bottom of the Vivado IDE.

If the Reports window is not open, you can open it with Windows > Reports. Select and
examine some of the reports from Place Design and Route Design. Close each of the reports
when you are done.

4. Select the Messages window tab at the bottom of the IDE.

If the Messages window is not open, you can open it with Windows > Messages.

Design Flows Overview Send Feedback 39
UG888 (v2014.2) June 4, 2014 [—\ /—]



http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG888&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Design%20Flows%20Overview&releaseVersion=2014.2&docPage=39

A
ALL PROGRAMMABLE.

Step 9: Analyzing the Implemented Design

5. Click the Collapse All button to condense all of the Messages. =
6. Expand the Implementation folder

View the messages from Design Initialization, Opt_Design, Place_Design, and Route_Design.
Analyzing Routing

After the design has been placed and routed, you can generate a timing report to verify that all
the timing constraints are met. You can select paths from the Timing Report window to examine
the routed path in the Device window. If there are timing problems, you can revisit the RTL
source files or design constraints to address any problems.

1. In the Device window, select the Routing Resources button &4 o display the device
routing.

This lets you see the routed connection in the Device window. Though you will need to
zoom closely into the device to see elements of the route, a zoomed-out view lets you see
the route in its entirety.

2. Select the Auto Fit Selection button o in the Device window toolbar menu to enable the
Vivado IDE to automatically zoom into and center the selected objects.

3. In the Flow Navigator, under Implemented Design, click on the Report Timing Summary
button.

4. Click OK in the Report Summary Timing dialog to generate the default report.

5. On the left side pane of the Timing Summary Results window, select:
Intra-Clock Paths > bftClk > SETUP...

In the table view on the right side of the Timing Summary Report window, click on any
timing path to select it and highlight it in the Device window. Select various paths in the
Timing Summary window and examine the path routing.

6. On the left side pane of the Timing Summary Results window, select:
Intra-Clock Paths > bftClk > HOLD...

Click on any path in the table view on the right side of the Timing Summary Results window
to select it and highlight it in the Device window. Select various paths in the Timing
Summary Results window and examine the path routing.
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Step 9: Analyzing the Implemented Design
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Figure 28: Examine Routing for Timing Paths

7. With a timing path selected, right-click to open the popup menu in either the Device view or

the Timing Summary window, and select the Schematic command

Note: Alternatively, you can press the F4 function key to open the Schematic window.

The Schematic window opens, displaying the schematic for the selected timing path. Use
commands from the popup menu in the Schematic window, such as Expand or Collapse
Outside, or Expand Cone, to traverse the schematic and examine the logic cells on the timing

path.

Close the Schematic window.

In the Device window, select the Routing Resources toolbar button again to turn off routing

resources.

The Device window now displays just the placed instances, without the added details of the

routed connections.

Design Flows Overview
UG888 (v2014.2) June 4, 2014

l Send Feedback I 41


http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG888&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Design%20Flows%20Overview&releaseVersion=2014.2&docPage=41

A
ALL PROGRAMMABLE.

Step 10: Generating a Bitstream file

Step 10: Generating a Bitstream file

With IOSTANDARDSs constraints defined for all of the I/O ports, and the logic of the design
placed with assigned LOCs, you can generate a bitstream. Before launching Write Bitstream, you
will review the settings for this command.

1. In the Flow Navigator, select Bitstream Settings under Program and Debug.

The Project Settings dialog box opens. The Bitstream Settings provides you access to the
options available for the write_bitstream command. For a complete description of these
options and how to use them, see the Vivado Design Suite User Guide: Programming and
Debugging (UG908).

glff_:. Project Settings IEI
P - Bitstream |
@ (i) Cconfiqure additional bitstream settings.
General
P = Write Bitstream (write_bitstream)
(LR
\.l td.pre
Simulation td.post
-raw_bitfile
@ -mask_file
Synthesis -no_binary_bitfile
-bin_file
D Jogic_location_file
Implementation Mare Options
'5} i
JO:
Bitstream
P
Select an option above to see a description of it
| OK | | Cancel Ar

Figure 29: Bitstream Settings

2. Click Cancel to close the Project Settings dialog box.

3. In the Flow Navigator, under the Program and Debug section, click on the Generate
Bitstream button.

4. After the bitstream has been generated, click OK in the Bitstream Generation Completed
dialog box to view the reports from the command.
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Step 11: Creating a Tcl Script from the Journal File

Step 11: Creating a Tcl Script from the Journal File

Running in batch mode is faster and takes less memory than running in the Vivado IDE. When
you need multiple runs to complete a design, it is a good idea to use a Tcl script to automate
the flow. You can also add report generation commands into the script after key steps, and
redirect the output to specific files and directories.

Vivado creates two files as it runs:

e The Vivado tools log (vivado. 1og) file contains the history and results of all Tcl commands
executed during the Vivado session.

e The Vivado tools journal (vivado.jou) file contains only the Tcl commands executed
during the Vivado session, without the added details recorded in the log file.

These files are a great way to learn the Tcl commands used by the Vivado tools to perform
different design tasks. The Vivado journal is also a great source of help when creating a new Tcl
script. Using the vivado. jou file from a completed design flow, you can see all of the Tcl
commands needed to complete the design. Refer to the Vivado Design Suite Tcl Command
Reference Guide (UG835) for a complete description of the Tcl commands and their options.

Examining the Log and Journal

In this step you manually create a Tcl script from the journal file that the Vivado tools
automatically created as you worked from Step 1 through Step 10 of this lab. When you execute
the new script, it will create a project file (. xpr) and directory structure just as you did when you
worked through these steps using the Vivado IDE. If you load this project into the Vivado IDE,
you will see all the results and project status displayed, as you would expect.

1. Select File > Exit, or type exit in the Tcl command line.
2. Click OK to close the Vivado tool.

3. Examine the Vivado log (vivado. 1og) file. On Windows, it may be easier to use the file
browser.
<Extract Dir>/Vivado_Tutorial/vivado.log

Note: This is the location you entered for the Start-in property in Step 1, Launching Vivado,
of Lab #2.

4. Examine the contents and close the file.
5. Open up vivado.jou file in a text editor.

6. Examine the Vivado journal file. On Windows, it may be easier to use the file browser.

<Extract Dir>/Vivado_Tutorial/vivado.jou

You should see something similar to Figure 30, with different file paths:
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¥
# Process ID: 8884

# Log file: C:/Data/Vivado Tutorial/vivado.log

# Journal file: C:/Data/Vivado_Tutoriall\vivado.jou
¥
start_gui

create_project project_bft C:/Data/Vivado Tutorial/Tutorial Created Data/project_bft —part xcTk70tfbg484-2

set_property simulator_language Verilog [current_project]

add files -force [C:/Data/Vivado Tutorial/Sources/hdl/bft.vhdl C:/Data/Vivado Tutorial/Sources/hdl/async fifo.w

C:/Data/Vivado Tutorial/Sources/hdl/FifoBuffer.v}

add files -fileset sim 1 -force C:/Data/Vivado Tutorial/Sources/hdl/bft_tb.v

add files -force C:/Data/Vivado_ Tutorial/Scurces/hdl/bftLib

set_property library bftLib [get_files [C:/Data/Vivado Tutorial/Sources/hdl/bftLib/round 4.vhdl

C:/Data/Vivado Tutorial/Sources/hdl/bftLib/round 3.vhdl C:/Data/Vivado Tutorial/Sources/hdl/bftLib/round 2.vhdl
C:/Data/Vivado_Tutorial/Sources/hdl/bftLib/round 1.vhdl C:/Data/Vivado_Tutorial/Scurces/hdl/bftLib/core_transform.vhdl
C:/Data/Vivado Tutorial/Sources/hdl/bftLib/bft_package.vhdl}]

import_files —force

import_files —fileset constrs_1 -force —norecurse C:/Data/Vivado Tutorial/Sources/bft_full kintex7.xdc

update compile order —-fileset sources 1

update_compile order —fileset sources_1

update_compile order —-fileset sim 1

synth_design -rtl -name rtl_1

launch xsim -simset sim 1 -mode behavioral

close_sim

launch runs synth_ 1

wait_on_run synth_1

launch_runs impl 1

wait_on_run impl_1

close_design

open_run synth 1 —name netlist_1

report_timing summary -delay type min max —report_ unconstrained —check timing verbose —max paths 10 -input_pins -name timing 1
report_power —name {power_ 1}

close_design

open_run impl 1

report_timing summary -delay type min max —report_unconstrained —check timing verbose —max paths 10 -input_pins -name timing 1
launch_runs impl 1 -to_step write bitstream

wait_on_run impl_1

Figure 30: Vivado Journal for Lab #2

7. Remove the comment header (lines starting with #) as unnecessary,

8. Remove any line sourcing the init.tcl script, which runs when the tool is launched.

9. Remove the start_gui line, since there is no need to open the Vivado IDE in a batch script.
10. Use the Save As command to save the file to <Extract Dir>/Vivado Tutorial/run_bft.tcl.

11. With the run_bft.tcl script opened, search and replace all occurrences of “project_bft” with
"project_bft_batch”.

12. Examine the script and notice the differences in this Project Mode script from the Non-
Project mode script used in Lab #1 of this Tutorial.

You should take note of the add files and set property commands used for project
creation, as well as the commands to set up the constraints sets. You should also notice that
launch runs is used instead of synth design, etc. Use the launch runs command
when creating or running Project based designs.

CAUTION! Mixing the individual commands (synth design, opt design..) with
launch runs could damage the Project, and is not recommended. The 1aunch runs

& command has Tcl options to run steps independently, and create intermediate reports. See the
Vivado Design Suite Tcl Command Reference Guide (UG835) for more information.
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Step 11: Creating a Tcl Script from the Journal File

Editing the Batch Project Script

If you did not complete Lab #2 of the tutorial in one design session, your vivado . jou file will
not reflect the complete design flow from step 1 through step 12. In this case, you can use the
run_bft kintex7 project.tcl script which can be found in the Vivado Tutorial
directory.

The first lines of the run_bft.tcl script create the design project and specify the target Xilinx
part; add the source RTL and XDC files; and define the VHDL library. The script creates synthesis
and implementation runs, synth_1 and impl_1, and defines the constraint set, constrs_1.

The next few lines elaborate the RTL design and simulate it. You don't need to do that in the
batch flow.

1. Add the —force option to the create_project command to over write an existing
project, so that you can run the script multiple times if necessary.

2. Remove the following lines from your script by deleting the lines, or inserting the ‘#' symbol
to make the lines comments in the Tcl script:
#synth design -rtl -name rtl 1
#close_design

#launch xsim -simset sim 1 -mode behavioral
#close_sim

In the previous steps in this tutorial, you ran synthesis and implementation, and analyzed the
synthesized design while implementation was running. In the batch flow, you will run
synthesis, then run the timing and power reports, and then run implementation. You need to
reorder the Tcl commands in the scrip to accomplish this. Cut the open_run command, and
the next three lines and move them up to follow the wait on run synth 1 command.

3. Cut the following lines:

open_run synth 1..
report timing summary..
report power..

4. Paste them after the wait_on_run synth_1... line.

Now the script launches synthesis, waits for synthesis to complete. Then launches
implementation and waits for implementation to complete. Finally, the script should launch
write bitstreamand wait for it to complete.

5. Remove the close_design line if one is in the file.
6. Save the file.

Your file should now look like Figure 31:
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create project -force project_bft_batch C:/Data/Vivado Tutorial/Tutorial_ Created Data/project_bft_batch -part xc7k70tfbg484-2
set_property simulator_ language Verilog [current project]

add_files —-force {C:/Data/Vivado Tutorial/Sources/hdl/bft.vhdl C:/Data/Vivado_Tutorial/Sources/hdl/async_fifo.w
C:/Data/Vivado Tutorial/Sources/hdl/FifoBuffer.v]

add files —-fileset sim 1 -force C:/Data/Vivado Tutorial/Sources/hdl/bft tb.v

add files —force C:/Data/Vivado_ Tutorial/Sources/hdl/bftLib

set_property library bftLib [get_files {[C:/Data/Vivade Tutorial/Sources/hdl/bftLib/round 4.vhdl
C:/Data/Vivado_Tutorial/Sources/hdl/bftLib/round_3.vhdl C:/Data/Vivado_Tutorial/Sources/hdl/bftLib/round 2.vhdl
C:/Data/Vivado_Tutorial/Socurces/hdl/bftLib/round_1.vhdl C:/Data/Vivado_Tutorial/Sources/hdl/bftLib/core transform.vhdl
C:/Data/Vivado_Tutorial/Scurces/hdl/bftLib/bft_package.vhdl}]

import_files —force

import files -fileset constrs 1 -force -norecurse C:/Data/Vivado_Tutorial/Sources/bft_full kintex7.xdec

update compile order -fileset sources 1

update compile order -fileset sources 1

update compile ocrder -—fileset sim 1

launch_runs synth_ 1

wait_on_run synth_1

open_run synth_1 -name netlist_1

report_timing_summary —delay type min_max —report_unconstrained —check_timing verbose —max_paths 10 —-input_pins -name timing 1
report_power -name [power_ 1}

launch runs impl_ 1

wait on_run impl 1

open_run impl 1

report timing summary -delay type min_max —report unceonstrained —check_timing verbose -max_paths 10 -input_pins -name timing 1
launch_runs impl_1 -to_step write_bitstream

wait_on_run impl_1

Figure 31: Edited Tcl Script

Running the Batch Project Script

You can now execute your new TCL script, running Vivado tools in batch mode, which will run all
the commands in your Tcl script and then quit Vivado when finished.

1. On Windows, open a Command Prompt window. On Linux, simply skip ahead to step 3.
2. Change directory to the Xilinx installation area, and run the settings32.bat or
settings64.bat as needed to setup the Xilinx tool paths for your computer:

cd <Vivado_ install area>/Vivado/2014.x
settings64

The settings64.bat file configures the path and environment on your computer to run the
Vivado tools.

3. Change directory to <Extract_Dir>/Vivado_Tutorial, and launch the Vivado tool in batch
mode:

cd <Extract Dir>/Vivado Tutorial
vivado -mode batch -source run bft.tcl

4. Examine the Vivado log output, as it is transcripted to the Command Prompt window.

Since the 1launch runs command is used, less information is echoed to the tool transcript.
Reports and run status are also gathered in the Project and will be available after the run
completes.

Because you ran the Vivado tool in batch mode, it exits after the sourced script has
completed running.
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Step 12: Checking the Design Status

1. Launch Vivado IDE and open the BFT batch project (project bft batch.xpr) thatyou
just created:

Start > All Programs > Xilinx Design Tools > Vivado 2014.x > Vivado 2014.x3

As an alternative, you can launch the Vivado IDE from the command line:

> cd <Extract Dir>/Vivado Tutorial/Tutorial Created Data
> vivado —-mode gui

The Vivado IDE will launch.
2. Open the project with File > Open Project, and locate project_bft_batch.

As you can see in the project status bar in the upper right of the Vivado IDE, the status
reflects the fact that a bitstream has been generated (write_bitstream Complete).

3. View the implemented design by clicking the Open Implemented Design button in the
Flow Navigator.

4. Quit the Vivado tool when you are finished. This concludes the tutorial.
File > Exit

Summary

After completing this tutorial, you should have learned the following:

e The use of Project Mode and Non-Project Mode.

e Creating an RTL project in the Vivado IDE.

e Configuring the Vivado synthesis, simulation and implementation tools.
e Launching the Vivado simulator, synthesis and implementation.

e Applying constraints to the synthesized design.

e Generating timing and power reports.

e Examining routing results in the Device editor.

e Generating a bitstream file.

e Using a Journal file (. jou) to create a project based Tcl script.

¢ Launching a project based Tcl script from the command line.

e Switching between the Vivado Design Suite Tcl shell and the Vivado IDE.

? Your Vivado Design Suite installation may called something different than Xilinx Design Tools
on the Start menu.
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